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Using Filtering Options

Question:	 I am using Excel 2007 for my sales report. I know I can use the Report Filter in the  
PivotTable to filter all the sales data. Is there a way that you can just filter a specific Row 
field, as I would like to filter my sales data by Date only?

Answer:	 Yes, using the new filtering options for Row and Column fields in Excel 2007.

Process (Excel 2007):

	 1.	 Open your sales report into Excel.

	 2.	 Open the PivotTable field list.

	 3.	 Hover over the words Date in the top of the PivotTable Field List and you see a drop-down  
appear.

	 4.	 Select the arrow and a drop-down menu opens. You can then filter on your Date field by select-
ing the Data filter option from the drop-down menu. Open the drop-down. Choose Date Filters. 
The next flyout menu offers filters for This Week, Next Month, Last Quarter, and others.  
If you want to filter to a specific month or quarter, choose All Dates in Period and select a month 
or quarter from the final flyout menu. See the example below:

 Simplify Your Intelligence Reporting Process  I  Excel Tips and Tricks Booklet  I  Volume 5 4



Using the DATEIF Function

Question:	 Is there a function in Excel that I can use to calculate the number of days between two 
dates? I would like to work out the number of days between an invoice date and invoice 
payment date.

Answer:	 Yes, using the DATEDIF function.

DATEDIF is not listed with other functions under the formula tab in Excel 2007. 

To use the function, you must type it manually into a cell on the worksheet rather than using the dialog 
box method available for other functions. 

The syntax for the DATEDIF function is:

= DATEDIF ( start_date , end_date , unit ) 

The function has three arguments that need to be entered as part of the function:

•	 start_date: the first or starting date

•	 end_date: the second or last date

•	 unit: tells the function to find the number of days (“D”), complete months (“M”), or complete 
years (“Y”) between the two dates

The unit argument can also be a combination of days, months, and years:

•	 “YM”—excludes years: calculates the number of months between two dates as if the dates 
were in the same year

•	 “YD”—excludes years: calculates the number of days between two dates as if the dates were 
in the same year

•	 “MD”—excludes months: calculates the number of days between two dates as if the dates 
were in the same month and year

Note: Commas are used as separators among the function’s three arguments. For help with this  
example, see the image below:

Process (Excel 2007):

	 1.	 Enter the following dates into cells C2 and D2: 1/30/2010 and 5/18/2010.

	 2.	 Click on cell E1 in the spreadsheet: this is where the function will be located.

	 3.	 Type “ = datedif “ in cell E1.

	 4.	 Type an opening round bracket “ ( “ after the function name in cell E1.

	 5.	 Click on cell C2 in the spreadsheet to enter the cell reference of the start_date into the function.

	 6.	 Type a comma ( , ) in cell E1 after C2 to act as a separator between the two cell references in 
the function.

	 7.	 Click on cell D2 in the spreadsheet to enter the cell reference of the end_date into the function 
after the first comma.

	 8.	 Type a second comma ( , ) in cell E1 following the second cell reference as a second separator.

	 9.	 For the unit argument, type the letter D in quotes (“D” ) in cell E1 after the second comma to tell 
the function you want to know the number of days between the two dates.
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	 10.	 Type the closing bracket “ ) “ 

	 11.	 Press the ENTER key on the keyboard.

	 12.	 The answer 108 should appear in cell E1 as there are 108 days between January 30  
and May 18.

You can follow the same process for the remaining dates.

If you get a #NUM! error in the cell where your function is located, it means that the start_date is larger 
(later in the year) than the end_date.

The Right Function

Question:	 I usually import data from our accounts system into Excel for further analysis. The difficulty 
I face is that the names are combined with the initials. However, I would like to analyze the 
data based on the initials. Is there a formula I can type so as to extract the initials quickly, 
given that the initials appear on the right side of the names?

Answer:	 Yes, by using the right function one can extract the specified number of characters from 
the right.

Why:	 To quickly extract the initials in order to analyze the data properly.

Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, and Excel 2000):

	 1.	 Enter data as given in the example below:

	 2.	 To extract the initials from the right, select D3 and type =Right (C3,1) and press enter.
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	 3.	 Copy the formula down and the screen below is displayed:

As can be seen above, the initials have been extracted from the right; hence, one can analyze the data 
further based on the initials.

	Publishing an Excel Workbook to an Intranet/ 
Internet Location
Question:	 We have adopted a policy in our company where the financial director is expected to 

publish quarterly financial results to the server/intranet. This can then be read by all the 
concerned parties. However, we only want to send a static copy of the statement/s.  
Is there an option in Excel that we can use to achieve our desired result?

Answer:	 Yes, using the Save as from the office icon/File menu.

Why:	 To save all or part of a workbook to a static web page that can then be autorepublished 
once changes are made to the source workbook.

Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, and Excel 2000):

	 1.	 Enter data as given in the example below:

	 2.	 To save, click the office icon/File menu. 

	 3.	 Select Save As, and enter income statement as the file name.
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	 4.	 Under the file extension, select Web Page. Refer to the screen shot below:

	 5.	 Select entire workbook and click the publish button.

	 6.	 Select the autorepublish every time this workbook is saved option.

	 7.	 Select the open published workbook in browser option.

	 8.	 Click the publish button.

	 9.	 Due to some security restrictions on some browsers, the option to allow the content to be 
displayed should be selected.

The financial statement is then displayed on the website in a static format. Hence, no changes can be 
made to the Data. Furthermore, when the source workbook is saved, the data is republished to the 
intranet/server.

Splitting of Windows

Question:	 Is it possible to view different parts of the data worksheet at the same time? For instance, 
when I import the payroll summary report from the payroll system, I would like to see the 
top ten and bottom ten earners. We have over 500 employees on our payroll, and this 
analysis is crucial in identifying the trends in our payroll.

Answer:	 Yes, with split panes option. A very handy feature of Excel is its ability to allow you view 
more than one copy of your worksheet and for you to be able to scroll through each pane 
of your worksheet independently. You can do this by using a feature called Split Panes, 
which allows you to split your worksheet both horizontally and vertically.

	 When you split panes, the panes of your worksheet work simultaneously. If you make a 
change in one, it simultaneously appears in the other. If you wish to move the split, just 
place your mouse over it, hold down your left mouse button, and drag to where you want 
it. To get rid of the split, just double click it or go to Window>Remove Split.

Why:	 In order to effectively analyze a huge list of data by viewing different parts of the worksheet 
simultaneously.

Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, and Excel 2000):

	 1.	 Open or create the desired spreadsheet, for instance payroll summary report. 

	 2.	 To split panes, point to the split box at the top of the vertical scroll bar or at the right end of the 
horizontal scroll bar for a vertical split. 

	 3.	 When the pointer changes to a split pointer      or      , drag the split box down or to the left to 
the position that you want.
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	 4.	 To remove the split, double-click any part of the split bar that divides the panes.

	 5.	 Alternatively select the View tab under the windows group then click Split (Excel 2007 and 
2010). For Excel 2003, XP, and 2000 click the windows menu and select Split. Refer to the 
screen shots below:

You are  therefore able to view different parts of the worksheets simultaneously and make informed  
decisions.

Multiple Data Consolidations for PivotTables

Question:	 As an effective tool for working with large volumes of data, I usually use PivotTables to 
summarize, organize, and view the same data in many different ways quickly and easily. 
However the data is usually in one data source/range. Is it possible to create a PivotTable 
based on multiple data consolidation ranges?

Answer:	 Yes, with the PivotTable multiple consolidation ranges option.

Why:	 To analyze data from multiple data consolidation ranges.

Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, Excel 2000, and  
Excel 1997):

	 1.	 Enter the data given below in the three worksheets; sheet 1, sheet 2, and sheet 3 respectively. 

		  Sheet 1:
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		  Sheet 2:

 

		  Sheet 3:

	 2.	 Insert/Select sheet 4.

	 3.	 For Excel 2007 and 2010 press ALT + D and then press/type P.

	 4.	 For Excel 2003, XP, 2000, and 97; click the Data menu and then PivotTable and PivotChart Report

	 5.	 The screen shot below is displayed.

	 6.	 Select Multiple consolidation ranges and PivotTable then click Next.

	 7.	 Select create a single page field for me and then click Next. The screen shot below is displayed.

	 8.	 Click the red arrow under Range and select the data range A1:B9 on sheet 1. 
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	 9.	 Press Enter and click the Add button.

	 10.	 Repeat steps 8 and 9 for data on sheet 2 and sheet 3. 

	 11.	 Click the Next button and select Existing Worksheet then click Finish.

As you can see a PivotTable with a multiple data consolidation range has been created. One can easily 
select the data to be displayed by selecting the appropriate option. The page option allows a user to 
select data for the respective worksheet. The worksheets are given as Item 1, Item 2 and Item 3.

Text Conversions

Question:	 I usually export my inventory data into Excel for further analysis. However, the product 
names appear in upper case when I do this. Is there a way of converting the product 
names to lower case and then capitalizing each word? How do I do this in Excel?

Answer:	 By using the proper function.

Why:	 To convert the text of data into proper case (capitalize each word).

Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, Excel 2000, and 
Excel 1997):

	 1.	 Given that you have the data below: 

	 2.	 Select cell E4 and type; =proper (D4).

	 3.	 Press Enter and copy the formula down. 

	 4.	 The result is the screen shot below:

The products names are now in proper case. This has been achieved by using one function, and the 
products names are now formatted correctly.
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Text Lengths in Excel

Question:  I need to export the stock list to our database program for further analysis. Last time I tried 
the routine, the names of the products were truncated because the wrong field size was 
used in the table. How can I return the number of characters in a text string? This will en-
able me to identify the maximum number as the field size when designing the table in the 
database.

Answer:	 By using the Len and Max functions.

Why:	 To identify the maximum number after counting the length of the text.

Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, Excel 2000, and  
Excel 1997):

	 1.	 Assuming that you want to count the text length for the products given below: 

	 2.	 Select cell D4 and type =Len(C4). 

	 3.	 Press the Enter key and copy the formula down.

	 4.	 Select cell D22 and type =Max(D4:D21). 

	 5.	 The screen shot below is displayed:

You are able to specify the correct field size (31) for the product names when designing the table in the 
database. Thus, there is no incomplete data through truncations when the stock list is exported to the 
database program.
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Excel Tip Error Trapping

Question:	 Excel is known for its excellent formulae and function capabilities. As such I extensively 
use Excel to calculate the variance between the target sales amount and the actual sales 
amount for our salesagents. However, sometimes the formula returns errors/error  
messages such as #DIV/0! Is there a way of trapping error messages so that a custom 
message is displayed instead of an error message?

Answer:	 Yes, with the IFError function.

Why:	 In order to trap error messages so that a custom message is displayed as opposed to an 
error message.

Process (Excel 2010 and Excel 2007):

	 1.	 Create the spreadsheet as in the example below:

	 2.	 Select cell G5 and type =-(E5-F5)/E5. Press Enter and autofill the formula down. 

	 3.	 The screen shot below with #DIV/0! error messages is displayed. The variance figures have 
been converted to percentage.

	 4.	 To rectify the errors above; select cell G5 and type:

		  =IFERROR(-(E5-F5)/E5,”Target not given”)
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	 5.	 The screen shot below is displayed. As you can see the variance has no error messages dis-
played; instead, a custom error message is given which gives, credibility to the data.

Customizing Ribbons

Question:	 I find it tiresome switching between ribbons in Excel 2010 when I am creating reports. Is 
there a way of customizing a ribbon so that I can group all the frequently used functions 
together?

Answer:	 Yes, by creating a custom ribbon in Excel 2010. 

Why:	 To group all the frequently used functions together.

Process (Excel 2010):

	 1.	 Click the File menu and select Options. The screen shot below is displayed:

	 2.	 Select “Customize Ribbon” as given above.

	 3.	 Click “New Tab” as given above. 

	 4.	 Rename the ribbon to Alchemex by clicking on the “Rename” button.
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	 5.	 The screen shot below is displayed.

	 6.	 Under “Popular Commands” select the respective icons and click the “Add” button. 

	 7.	 To organize the custom ribbon in groups, click the “New Group” command and repeat step 6.

	 8.	 Repeat steps 6 and 7 until the new ribbon has been created. Thereafter click the “OK” button.

		  A new custom Alchemex Ribbon appears on the Excel ribbon. The commonly used functions  
is thus placed in one group. The user can easily access those functions and eventually  
save on time.

Personal Macro Custom Format

Question:  Can you help me to apply custom format for employee numbers to all Excel workbooks 
on my computer? I would like the employee numbers to have preceding zeros, such as 
001,002,003, and so on.

Answer:	 Yes, with the Personal Macro workbook option. 

Why:	 For the custom format to apply to all workbooks on the computer.
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Process (Excel 2010, Excel 2007, Excel 2003, Excel XP, and Excel 2000):

	 1.	 Enter the data as given in the example below:

	 2.	 For Excel 2007 and 2010 click the View ribbon and then Macros-Record, New Macro.  
For other versions of Excel, click Tools-Macro-Record, New Macros.

	 3.	 Make changes as given below: 

	 4.	 Click OK and select the relative reference button. (This enables the macro to run in any location 
within the worksheet.) For Excel 2007 and 2010 click View-Macros-Use Relative Reference. For 
other versions of Excel click the relative reference icon as given below:

	 5.	 Right-click in any cell. Select format cells and make changes as given below:

	 6.	 Click OK; select the relative reference button again. 
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	 7.	 Excel 2007 and 2010: select View-Macros-Stop recording, and lower versions of  
Excel: Tools-Macro-Stop Recording.

	 8.	 Open the target workbook and highlight the respective employee numbers.

	 9.	 Excel 2007 and 2010: select View-Macros-View Macros, and lower versions of  
Excel: Tools-Macro-Macros. The screen shot below is displayed. 

	 10.	 Click the drop arrow next to macros in, and select Personal.XLSB. Select the Employee  
Numbers macro and click the run button.

	The EmployeeNumbers macro runs in any workbook and applies the custom number format.  
In that way the process of applying custom number formats in the workbooks is automated.

Text Function in Excel

Question:	 Given that I have a column of dates in values in my report, how can I only show the name 
of the months, and can this be done in Microsoft Excel?

Answer:	 Yes, by using the text function in Excel.

Why:	 The Text function coverts a value to text in a specific number format.

Process (Excel 2010, Excel 2007, and Excel 2003):

	 1.	 Refer to the data in the Excel worksheet as given in the example below:
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	 2.	 Select C3.

	 3.	 Type;=Text(C3,”MMMM”). 

	 4.	 Press enter and copy the formula down.

	 5.	 The result is as in the screen shot below:

	You can also use the following formula if you would like a shorter text format:

	Type;=Text(C3,”MMM”)

This would give the result Jan, Feb, Mar for example.

As can be seen above the name of the months have been extracted. Analysis in terms of how much 
sales were made in each month can easily be done now.

Mail Merge

Question:  How can I merge MS Excel with MS Word, given that we have a list of clients stored in MS 
Excel? Are we able to automate the sending of statements to clients?

Answer:	 Yes, by merging MS Excel with MS Word.

Why:	 To automate the sending of documents by merging MS Excel with MS Word.

Process (Excel 2010, Excel 2007, and Excel 2003):

	 1.	 Refer to the data as given in the example below:
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	 2.	 Open MS Word and create the template below:

	 3.	 For MS Word 2007 and 2010 click the mailings tab and select start mail merge  
(in the select mail merge group) then step by step mail merge wizard. 

	 4.	 For MS Word 2003 and lower, click the tools menu, letters and mailings, then mail merge.

	 5.	 Click Next on the bottom right-hand side until you reach step 3.

	 6.	 Select the browse option.

	 7.	 Locate your MS Excel client database and click OK twice. 

	 8.	 For MS Word 2007 and 2010 select the cell below customer name in the statement template 
and click insert merge field (under the write and insert fields groups).

	 9.	 From the field list select customer name.

	 10.	 Repeat steps 8-9 until you have inserted all the merge fields.

	 11.	 For MS Word 2003 and lower; click tools—letters and mailings—show mail merge toolbar. 

	 12.	 On the mail merge toolbar locate the insert merge field icon (next to insert word field) and repeat 
steps 8-9.

	 13.	 Click the next button until you reach step 6.

	 14.	 You can then print or edit the individual letters.

The number of letters/statements that are created is equal to the number of clients in the database. In 
that way the process of sending documents to clients is automated. Meaning an organization with a 
lot of clients is able to effectively and efficiently send mass mails to its clients.

Negative Data Bars

Question:  We have just upgraded from MS Excel 2007 to MS Excel 2010. When applying  
conditional formatting in MS Excel 2007, we were unable to display negative data bars. 
Can this be done in MS Excel 2010?

Answer:	 Yes, by using conditional formatting.

Why:	 To create data bars for negative and positive values.
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Process (Excel 2010):

	 1.	 The screen shot given below has negative and positive stock in/out values:

	 2.	 Highlight the stock in/out values.

	 3.	 Select conditional formatting under the home tab. 

	 4.	 Select data bars.

	 5.	 Select the data bar of your choice.

	 6.	 The data bars below is displayed:

	 7.	 To customize your data bars, repeat steps 3 and 4 and then select More rules. 

	 8.	 Refer to the screen shot below:
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You can then customize the data bars, negative values, and axis. Data bars for negative and positive 
values have been created. You can then easily analyze and interpret the data in MS Excel 2010 by us-
ing conditional formatting and assigning rules to the conditional formatting.

Mandatory Cell Input

Question:  How do I make a specific cell mandatory to fill in in an Excel workbook? We have a form 
that employees fill in but require that important information like employee names to be 
mandatory. Can this be done in Excel?

Answer:	 Yes, by using Visual Basic For Applications (VBA).

Why:	 To make a specific cell mandatory.

Process (Excel 2010, Excel 2007, and Excel 2003):

Example: Make cell B3 mandatory for completion in a workbook.

	 1.	 Open Excel.

	 2.	 Press Alt + F11 to open VBA for Excel.

	 3.	 Double-click on this workbook on the drop-down list. 

	 4.	 If the above option is not available, then select view–project explorer, and you’ll be able to  
proceed with the below steps.

	 5.	 On your top right-hand side select the first drop-down arrow and choose workbook as given 
below:

	 6.	 Select the second drop-down arrow and choose BeforeSave as displayed below
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	 7.	 Enter the following code:

		  If Cells(3, 2).Value = “” Then

       	     MsgBox “Cell B3 requires user input”

     	      	 Cancel = True

     	  	 End If

	 8.	 Save the Macro.

	 9.	 To return to Excel, press ALT + Q.

	 10.	 Save the workbook (For Excel 2007 and Excel 2010 save workbook as a .xlsm).

	 11.	 When you save the workbook, it prompts you to fill in B3 before saving.

This tip only works when one tries to save, meaning the workbook won’t be saved as long as cell 
B3 is empty. By so doing, cell B3 is now a mandatory cell. Important information such as employee 
names are thus entered, resulting in forms’ being completed. You may have to check your macro 
security settings should the tip not work. 

Removing Duplicates

Question:  Is there an automated way of deleting duplicate data rows from a worksheet? 

Answer:	 Yes, by using remove duplicates data tool.

Why:	 To remove duplicate values from a worksheet.
 
Process (Excel 2010 and Excel 2007): 

With reference to the data given below staff codes, P1, P2, and P7 have duplicate values:	

	 1.	 Highlight the data table. You may include/exclude the heading row.
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	 2.	 Select the Data tab and Select Remove Duplicates under the Data Tools group. Refer to the 
image below:

	 3.	 The screen shot below is displayed: 

	 4.	 In order to delete duplicate values, at least one column that contain duplicates must be  
selected.

	 5.	 Select OK, and refer to the dialogue box below. Thereafter select OK again.

The duplicate data rows have been deleted from the worksheet. The user can therefore not locate and 
delete the duplicate values manually, and this results in time saving.

Solver (Recovered)

Question:  I acquired a loan of $20,000. The repayment period is three years at 10% per annum. Is 
there a way to work out the current repayment? I can afford to pay $1,000 per month and 
would like to know the new repayment period, too. 

Answer:	 By first using the Payment function, and then using the solver option one can find  
a solution.

Why:	 To calculate the new repayment period for a loan amount.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Using the example given above, create a worksheet as per the screen below:

 Simplify Your Intelligence Reporting Process  I  Excel Tips and Tricks Booklet  I  Volume 5 23



	 2.	 Work out the current installment using the payment function. Select cell C7, (Monthly Payment), 
and type: =PMT(C6/12,C5,-C4).

	 3.	 Calculate the payment for a loan based on constant payments and a constant interest rate. 

	 4.	 PMT(rate, nper, pv, [fv], [type])

			   Rate Required. The interest rate for the loan.

			   Nper Required. The total number of payments for the loan.

			   Pv Required. The present value or the total amount that a series of future payments is worth 		
	 now; also known as the principal.

			   Fv Optional. The future value or a cash balance you want to attain after the last payment is 		
	 made. If fv is omitted, it is assumed to be 0 (zero), that is, the future value of a loan is 0. 

			   Type Optional. The number 0 (zero) or 1 and indicates when payments are due.

	 5.	 The answer is $645.34.

	 6.	 Now select Solver under Data—What If Analysis—Data tools group.

	 7.	 If the solver option is not installed, select the link below for instructions on how to add the 
solver: http://www.alchemex.com/Resources/EOS%20Previous%20Tips%20And%20Tricks/
Solver%20Add–in.pdf 

	 8.	 When you add the solver option, select as given below:

	 9.	 Make changes as illustrated below:

	 10.	 Select the Add button and effect the changes below:

	 11.	 Select OK. 
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	 12.	 Select the Solve button and refer to the screen shot below:

	 13.	 Select OK.

The new repayment period is 22 months. Thus, one can easily calculate how long it will take to settle  
a loan amount based on new variables. The interest rate is envisaged not to exceed 15% in the  
stipulated period. The answer, sensitivity, and limits reports have also been generated to the left of  
the active worksheet.

Database Functions

Question:	 I have a list of product sales with different transaction dates. How do I calculate the total 
sales for transactions between 2009/03/20 and 2009/03/30 by using one formula?  

Answer:	 By using the DSUM function [adds the numbers in a field (column) of records in a list or 
database that match conditions that you specify].

Why:	 To calculate the total sales for products, for given a criteria range.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Using the Excel worksheet below:

	 2.	 You must use copy and paste to enter the data labels in H4 & I4.

	 3.	 Use the DSUM function DSUM(database, field, criteria). 

	 4.	 Select cell I8 and enter: =DSUM(B4:F23,5,H4:I5).

	 5.	 The answer is $2,271.50.

By using one formula the total sales for transactions between 2009/03/20 and 2009/03/30 have been 
easily calculated. This demonstrates the power of database functions like DSUM.

 Simplify Your Intelligence Reporting Process  I  Excel Tips and Tricks Booklet  I  Volume 5 25



More on the Database Function

The DSUM function syntax has the following arguments:

	Database Required. The range of cells that makes up the list or database. A database is a list of 
related data in which rows of related information are records, and columns of data are fields. The first 
row of the list contains labels for each column.

	Field Required. Indicates which column is used in the function. Enter the column label enclosed be-
tween double quotation marks, such as “Age” or “Yield,” or a number (without quotation marks) that 
represents the position of the column within the list: 1 for the first column, 2 for the second column, 
and so on.

	Criteria Required. Is the range of cells that contains the conditions that you specify? You can use any 
range for the criteria argument, as long as it includes at least one column label and at least one cell 
below the column label in which you specify a condition for the column.

Subtotal

Question:	 I have a long data list of products and selling prices stored in an Excel sheet. Is it possible 
to have a breakdown of subtotals for each product category?  

Answer:	 Yes, by using the subtotal option in Excel.

Why:	 To automatically insert subtotals and totals for the selected cells.

Note: The Subtotal command appears grayed out if you are working with a Microsoft Excel table. To 
add subtotals in a table, you must first convert the table to a normal range of data and then add the 
subtotal. Note that this removes all table functionality from the data except table formatting.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the screen shot in the example below:

	 2.	 The list must be sorted by category names for the subtotal option to be effective.
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	 3.	 Select any cell within the data list and select data-subtotal as given below:

	 4.	 The screen shot below is displayed:

	 5.	 Select the options as given above.

	 6.	 Select OK.

	 7.	 The data given below is displayed:

As can be seen above, the data has been grouped by the category names whose subtotals for  
product sales are displayed.
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PivotTable

Question:  How do I create an interactive report that can quickly be used to summarize large 
amounts of data?  

Answer:	 By using a PivotTable.

Why:	 A PivotTable report is useful to summarize, analyze, explore, and present summary data.  
A PivotTable enables you to make informed decisions about critical data in your enterprise.

Note: The Subtotal command appears grayed out if you are working with a Microsoft Excel table. To 
add subtotals in a table, you must first convert the table to a normal range of data and then add the 
subtotal. Note that this removes all table functionality from the data except table formatting.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data as given in the example below:

	 2.	 Select any cell in the list.

	 3.	 From the insert tab, in the tables group, select PivotTable and click OK. 

	 4.	 Drag the category name and product name fields to the row labels area.

	 5.	 Drag the quantity, unit price, and product sales fields to the values area as given below:
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	 6.	 To display data for the products under the seafood category; select the drop-down arrow under 
row labels and select Seafood as below.

	 7.	 The following PivotTable is given:

The data given in step 1 above can be summarized and queried in many user-friendly ways. 

The Design of a PivotTable allows you to:

•	 Query large amounts of data in many user-friendly ways.

•	 Subtotal and aggregate numeric data, summarize data by categories and subcategories, and 
create custom calculations and formulas.

•	 Expand and collapse levels of data to focus your results and drill down to details from the  
summary data for areas of interest to you.

•	 Move rows to columns or columns to rows (or “pivot”) to see different summaries of the  
source data. 

•	 Filter, sort, group, and conditionally format the most useful and interesting subset of data  
to enable you to focus on the information that you want.

•	 Present concise, attractive, and annotated online or printed reports.

Notes

How a PivotTable Field List Works:

 

1.	 Data Source (Excel, Cube, Database)

2.	 Report Filter (Department)

3.	 Column Label Area (Branch)

4.	 Row Label Area (Customer Name)

5.	 Values Area (Sales Amount)
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PivotTable Calculated Fields

Question:  How can I create my own calculated fields to include in the PivotTable? I intend to have a 
markup of 25% on the sales figure and then calculate the profit. 

Answer:	 By using the PivotTable formulae option.

Why:	 To create calculated fields.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 This example is based on the previous tip on how to create a PivotTable. The link is given below:

		  http://www.alchemex.com/Resources/EOS Previous Tips And Tricks/PivotTable.pdf

	 2.	 Select any cell in the PivotTable.

	 3.	 Select as given below:

		  Excel 2007

 

		  Excel 2010

	 4.	 The Insert a Calculated field window opens. Enter the following and select Add.

	 5.	 Rename the field on the PivotTable to Markup (double click on “sum of Markup” field, delete the 
words “sum of” and press enter).

	 6.	 Repeat the Process to calculate Profit.
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	 7.	 Enter the following and select add.

	 8.	 Select OK.

	 9.	 Rename the field on the PivotTable to Profit.

	 10.	 The result is as given below:

The Markup and Profit figures have been computed by way of adding two calculated fields  
to the PivotTable.

Using Value Field Settings in PivotTables

Question:  I would like to have two fields for analyzing sales in the PivotTable, one in a percentage 
format and the other in a value format. How can I accomplish this? 

Answer:	 By using the Value Field Settings.

Why:	 To display the Product sales field in percentage and value formats.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 For an example on how to create PivotTables refer to the link given below: 

		  http://www.alchemex.com/Resources/EOS Previous Tips And Tricks/PivotTable.pdf

	 2.	 Select any cell in the PivotTable as given in the above example.

	 3.	 If the Pivot Table field list is not displayed, select field list button on the Options tab in Excel.
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	 4.	 Add the product Sales column to the values area again. Refer to the screen shot given below:

 

	 5.	 Change the Sum of Product Sales2 field to a %;

			   (a) Right-click on the field Sum of Product Sales 2 in the PivotTable.

			   (b) Select values field setting and select as below.

		  MS Excel 2007/MS Excel 2010

	 6.	 The result is the PivotTable shown below:

The analysis of sales by percentage and values can thus be performed. One can easily compare the 
sales of the various products by looking at the percentage column for the product sales.

You can now change the name of the Fields to be more appropriate. For example, Sum of Product 
Sales = Product Sales Total; Sum of Product Sales2 = % of Total Sales

Conditional Formatting

Question:	 In Excel 2010, is there a way to automatically highlight upcoming and past due dates? 

	 For example, I have dates that stock will expire in a spreadsheet. I would like Excel to 
highlight the ones that have expired and those that are 30 days from expiration in green.  
Is that possible?

Answer:	 Yes, you can use conditional formatting to achieve exactly what you are looking for.
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Process (Excel 2010): 

	 1.	 Highlight the range of cells that you want to apply the formatting to. In this example, we’ve 
selected all of the dates in Column B.

	 2.	 Select the Home tab in the toolbar at the top of the screen. Then in the Styles group, click the 
Conditional Formatting drop-down and select Manage Rules.

	 3.	 When the Conditional Formatting Rules Manager window appears, click on the “New Rule” 
button to enter the first condition. 

	 4.	 When the New Formatting Rule window appears, select Format only cells that contain as the 
rule type.

	 5.	 Select Cell Value in the first drop-down, less than in the second drop-down, and enter the  
following formula:

		  =NOW()+30

	 6.	 Select what formatting to apply when this condition is met. To do this, click the  
Format button.
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	 7.	 When the Format Cells window appears, select the Fill tab. Then select the color that you’d like 
to see the dates that will expire in the next 30 days. In this example, we’ve selected green. Then 
click the OK button.

	 8.	 When you return to the New Formatting Rule window, you should see the preview of the for-
matting in the Preview box. In this example, the preview box shows green as the fill color. Next 
click the OK button.
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	 9.	 This returns you to the Conditional Formatting Rules Manager window. Select OK.

	 10.	 The stock that has already expired and the stock that will expire in less than 30 days from now 
are highlighted in green.

Data Validation

Question:	 I have a list of all the company’s employees in an Excel report and would like to assign 
the specific department they work in. Is there a way to do this without having to type the 
department next to each employee’s name? 

Answer:	 Yes, by using Data Validation in Excel.

Why:	 You use data validation to control the type of data or the values that users enter into a cell.  
For example, you may want to restrict data entry to a certain range of dates, limit choices 
by using a list.

 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 First create a list in an Excel Worksheet for the Department Names.

	 2.	 Select sheet 1 worksheet tab and enter as below:
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	 3.	 Select A3:A10 and enter Dept in the name box (you must press the enter key after typing Dept). 

	 4.	 Select sheet 2 worksheet tab, and select the cells in the Department Column of the report 
(E5:E17).

	 5.	 Add the Data Validation to the selected cells. Refer to the screen shot below:

	 6.	 The following screen is displayed; select the criteria as shown below.

		  To insert the range name (Dept.) you can either type in =Dept or press F3 in the Source text box 
and then select Dept from the list of Named Ranges.

	 7.	 Select OK and enter employees’ information. To choose the department, select the drop-down 
arrow in column E. A list of departments is displayed, thus automating the entry of departments 
into the worksheet. The screen shot is displayed below:
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Excel File Formats

Question:	 I am using Excel 2010, and some people in the organization are using Excel 2007 and  
Excel 2003. Some of the Excel reports they send have very different formats from the 
ones I know in Excel 2010. What is the difference between the Excel file formats?

Excel File formats Explained:
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Format Extension Description

Excel Workbook .xlsx The default XML-based file format for Excel 2010 and 
Excel 2007. Cannot store Microsoft Visual Basic for  
Applications (VBA) macro code or Microsoft Office Excel 
4.0 macro sheets (.xlm).

Excel Workbook 
(code)

.xlsm The XML-based and macro-enabled file format for Excel 
2010 and Excel 2007. Stores VBA macro code or Excel 
4.0 macro sheets (.xlm). 

Excel Binary 
Workbook

.xlsb The binary file format (BIFF12) for Excel 2010 and Excel 
2007.

Template .xltx The default file format for an Excel template for Excel 2010 
and Excel 2007. Cannot store VBA macro code or Excel 
4.0 macro sheets (.xlm).

Template (code) .xltm The macro-enabled file format for an Excel template Excel 
2010 and Excel 2007. Stores VBA macro code or Excel 
4.0 macro sheets (.xlm).

Excel 97- Excel 
2003 Workbook

.xls The Excel 97-Excel 2003 Binary file format (BIFF8).

Excel 97- Excel 
2003 Template

.xlt The Excel 97-Excel 2003 Binary file format (BIFF8) for an 
Excel template.

Format Extension Description

Microsoft Excel 
5.0/95 Work-
book

.xls The Excel 5.0/95 Binary file format (BIFF5).

XML Spread-
sheet 2003

.xml XML Spreadsheet 2003 file format (XMLSS).

XML Data .xml XML Data format.

Excel Add-in .xlam The XML-based and macro-enabled Add-in format for 
Excel 2010 and Excel 2007. An Add-in is a supplemental 
program that is designed to run additional code. Supports 
the use of VBA projects and Excel 4.0 macro sheets (.xlm).

Excel 97-2003 
Add-in

.xla The Excel 97-2003 Add-in, a supplemental program that is 
designed to run additional code. Supports the use of VBA 
projects.

Excel 4.0 Work-
book

.xlw An Excel 4.0 file format that saves only worksheets, chart 
sheets, and macro sheets. You can open a workbook in 
this file format in Excel 2010, but you cannot save an Excel 
file to this file format.



Rank Function

Question:	 How do I return the rank of a number in a list of numbers relative to other values in a list?   

Answer:	 By using the RANK function in Excel. The function returns the rank of a number in a list of 
numbers. The rank of a number is its size relative to other values in a list. (If you were to 
sort the list, the rank of the number would be its position.)

Why:	 To rank numbers in a given list so that one can easily determine the top performing  
product.

 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below:

	 2.	 Select cell F3 and type; =Rank(E3,$E$3:$E$11)

		  RANK(number,ref,[order])

		  The RANK function syntax has the following arguments (argument: a value that provides  
information to an action, an event, a method, a property, a function, or a procedure):

		  Number  (Required). The number whose rank you want to find.

		  Ref  (Required). An array of, or a reference to, a list of numbers. Nonnumeric values in ref  
are ignored.

		  Order  (Optional). A number specifying how to rank number.

		  If order is 0 (zero) or omitted, Microsoft Excel ranks number as if ref were a list sorted in  
descending order.

If order is any nonzero value, Microsoft Excel ranks number as if ref were a list sorted in  
ascending order.

	 3.	 Press Enter and copy the formula down.

	 4.	 The result is the screen shot below:

The products sales have now being ranked in order of Product Sales Amount, and one can easily 
determine the best performing product by looking at the rank column and checking the corresponding 
product name.
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PV Function

Question:	 How much deposit do I need to pay in order to have a monthly installment of $400 over a 
period of four years for a car costing $15,000? The interest rate is 8.5%.   

Answer:	 The PV function can be used to find a solution. The PV Function returns the present value 
of an investment. The present value is the total amount that a series of future payments is 
worth now. For example, when you borrow money, the loan amount is the present value to 
the lender.

Why:	 To calculate the amount of deposit to be paid for a car costing $15,000.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Select Formulas - Insert function > Financial and select as below:

	 2.	 Select OK and enter as below:

	 3.	 Select OK.

The amount of deposit to be paid for a car costing $15 ,000 at a monthly installment of $400 over four 
years and interest rate of 8.5% is $5,538.94. You can also type the formula in excel as: 			 
	=PV(8.5%/12,48,- 400,15000)
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PV(rate, nper, pmt, [fv], [type])

The PV function syntax has the following arguments (argument: a value that provides information to an 
action, an event, a method, a property, a function, or a procedure)

•	 Rate Required. The interest rate per period. For example, if you obtain an automobile loan at 
a 10 percent annual interest rate and make monthly payments, your interest rate per month is 
10%/12, or 0.83%. You would enter 10%/12, or 0.83%, or 0.0083, into the formula as the rate.

•	 Nper Required. The total number of payment periods in an annuity. For example, if you get a 
four-year car loan and make monthly payments, your loan has 4*12 (or 48) periods. You would 
enter 48 into the formula for nper.

•	 Pmt Required. The payment made each period and cannot change over the life of the annu-
ity. Typically, pmt includes principal and interest but no other fees or taxes. For example, the 
monthly payments on a $10,000, four-year car loan at 12 percent are $263.33. You would enter 
-263.33 into the formula as the pmt. If pmt is omitted, you must include the fv argument.

•	 Fv Optional. The future value or a cash balance you want to attain after the last payment is 
made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). For 
example, if you want to save $50,000 to pay for a special project in 18 years, then $50,000 is 
the future value. You could then make a conservative guess at an interest rate and determine 
how much you must save each month. If fv is omitted, you must include the pmt argument.

•	 Type Optional. The number 0 or 1 and indicates when payments are due.

Two Chart Types

Question:  Is it possible to combine two or more chart types in a chart?   

Answer:	 Yes.

Why:	 To display the results of different sets of data in one graph.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below:

	 2.	 Select any cell within the data range.

	 3.	 Select as below:
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	 4.	 The following chart is displayed:

	 5.	 To insert the heading select the chart and select as below:

	 6.	 Select the average price bars in the chart and as below:

	 7.	 Two charts (line and column) is displayed.

	 8.	 Right select the line graph and select as below:

	 9.	 Select Secondary axis and then the close button.

	 10.	 The following chart is displayed:

Two graphs with separate axis have been combined in one chart. Therefore one can easily interpret 
the different sets of data in the chart.
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Workdays

Question:	 How can I calculate the number of workdays between two dates? The usual off days are 
Saturday, Sunday, and public holidays.    

Answer:	 By using the Networkdays function.

Why:	 To calculate the number of workdays between two dates.
 
Process (Excel 2010 and Excel 2007): 

	 1.	 The data below is used for illustration purposes:

	 2.	 Select cell A7.

	 3.	 Select Formulas>Date & Time>NETWORKDAYS. Refer to the screen shot below:

	 4.	 Enter as below and select OK:

The number of workdays between the two given dates is 78. The formula can also be entered  
in this way:

=NETWORKDAYS (A3,A4,A5:A6). 

The formula subtracts the usual weekend days and any specified holidays from the difference between 
the start and end dates of the project.
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Trends

Question:	 Is there a function in MS Excel that can be used to predict future sales based on past 
performance or sales trends?    

Answer:	 Yes, by using the Trend function. 

	 Description: Returns values along a linear trend. Fits a straight line (using the method of 
least squares) to the arrays known_y’s and known_x’s. Returns the y-values along that line 
for the array of new_x’s that you specify

	 Syntax: TREND(known_y’s, [known_x’s], [new_x’s], [const])

Why:	 To predict future sales based on past performance or trends.
 
Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 The data below is used for illustration purposes:

	 2.	 To predict the sales for periods 10, 11, and12. Select cell B11 and enter; 
=Trend(B2:B10,A2:A10,A11:A13).

	 3.	 The projected sales for periods 10, 11, and 12 is as below:

The projected sales for periods 10, 11, and 12 can thus be estimated based on past trend  
or performance.

 Simplify Your Intelligence Reporting Process  I  Excel Tips and Tricks Booklet  I  Volume 5 43



Aggregate Function

Question:	 How do I calculate the sum for a range of numbers with error values within the range?  
Using the standard sum function in Microsoft Excel returns an error.    

Answer:	 By using the Aggregate function in MS Excel 2010. 

	 Description: The AGGREGATE function addresses the limitation of conditional format-
ting. Data bars, Icon Sets, and Color Scales cannot display conditional formatting if there 
are errors in the range. This is because the MIN, MAX, and PERCENTILE functions do 
not calculate when there is an error in the calculation range. The LARGE, SMALL, and 
STDEVP functions also affect the appropriate functionality of certain conditional formatting 
rules for the same reasons. By using the AGGREGATE function, you can implement those 
functions because the errors are ignored. In addition, the AGGREGATE function can apply 
different aggregate functions to a list or database with the option to ignore hidden rows 
and error values.

	 Syntax: AGGREGATE(function_num, options, ref1, [ref2], …)

Why:	 To find the sum for a range of numbers where there are error values within the range.

Process (Excel 2010): 

	 1.	 Refer to the data given below:

	 2.	 Select B11 and enter; =sum(B5:B10) and press enter.

	 3.	 An error message is displayed in the Total. Delete the error message in cell B11.

	 4.	 To overcome this limitation, use the Aggregate function.

	 5.	 Select cell B11.

	 6.	 Select Formulas, Insert Function and search for the Aggregate function.

	 7.	 Select OK.

	 8.	 Select as below:
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	 9.	 Enter as below:

	 10.	 Select OK.

	 11.	 The answer is as below:

The following numbers represent some function numbers than can be used in the formula above:

1=Average,2=Count,3=CountA,4=Max,5=Min,9=Sum.

For Option numbers refer to the table below:
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OPTION BEHAVIOUR

0 or omitted Ignore nested SUBTOTAL, and AGGREGATE functions 

1 Ignore hidden rows, nested SUBTOTAL, and AGGREGATE 
functions 

2 Ignore error values, nested SUBTOTAL, and AGGREGATE 
functions 

3 Ignore hidden rows, error values, nested SUBTOTAL, and 
AGGREGATE functions

4 Ignore nothing

5 Ignore hidden rows

6 Ignore error values

7 Ignore hidden rows and error values



Subtotal Command

Question:	 I have a list of sales transactions for various months. How can I quickly calculate the total 
sales for each month?    

Answer:	 By using the Subtotal command. 

Why:	 To calculate the total sales for each month.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below:

	 2.	 The data must be sorted. Select any cell within the date column (column B).

	 3.	 Select as below to sort in ascending order:

	 4.	 Select Data, Subtotal.
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	 5.	 Select as below:

	 6.	 Select OK. The data below is displayed:

	 7.	 The subtotals for each month are computed as above. To display the Grand total value, select 1.

	 8.	 For the monthly totals only select 2. To display the entire data list with subtotals for each month, 
select 3.
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Excel Web Query

Question:	 Is it possible to link a table from an intranet/Internet website to my spreadsheet?   

Answer:	 Yes, by using the get external data from web option (web query). 

Why:	 You can use a web query to retrieve refreshable data that is stored on your intranet or 
the Internet, such as a single table, multiple tables, or all of the text on a web page. Then 
you can analyze the data by using the tools and features in Excel. For example, you can 
retrieve and update stock quotes from a public web page or retrieve and update a table of 
sales information from a company web page.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Select Data, From Web.

	 2.	 Enter the URL where you would like to import the table from, and then select go.

	 3.	 Select on the arrow alongside the table you wish to query. See below:

	 4.	 Select the location, (the cell you would like to insert the data in), of the data and select OK.
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	 5.	 The data is displayed as below:

The table/data can then be updated or refreshed by selecting Data, Refresh All. In this way the latest 
data will be displayed in MS Excel spreadsheet. MS Excel functionality can also be used to analyze or 
format the data.

Subtotal Visible Cells

Question:	 How can I quickly calculate the total sales for each month and copy only the visible cells 
or subtotals to a new worksheet?   

Answer:	 By using the Subtotal command and visible cells only option. 

Why:	 If some cells, rows, or columns on the worksheet are not displayed, you have the option 
of copying all cells or only the visible cells. By default, Excel copies hidden or filtered cells 
in addition to visible cells. If this is not what you want, follow the steps in this tip to copy 
visible cells only. For example, you can choose to copy only the displayed summary data 
on an outlined worksheet.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below:
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	 2.	 When a subtotal command is applied to the sorted data the result is as below:

	 3.	 To display only the monthly totals, select as below:

	 4.	 To select only the visible cells as given above:

			   a. On the Home tab, in the Editing group, click Find & Select, and then click Go To Special

			   b. Under Select, click Visible cells only, and then click OK

			   c. On the Home tab, in the Clipboard group, click Copy       (Keyboard shortcut: CTRL+C)

			   d. Select the upper-left cell of the paste area. 

			   e. On the Home tab, in the Clipboard group, click Paste       (Keyboard shortcut: CTRL+V)

 Simplify Your Intelligence Reporting Process  I  Excel Tips and Tricks Booklet  I  Volume 5 50



Simplify Your Intelligence Reporting Process  I  Excel Tips and Tricks Booklet  I  Volume 5 51

Future Dates Projection

Question:	 How can I calculate the date that a project ends if this date falls after a certain amount of 
years, months, and days?   

Answer:	 By using the Date function, =Date(Year,month,Day). 

Why:	 To predict the completion date of a project.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data below:

	 2.	 To predict the project end date, select B8 an, enter as below:

		  =Date(2011+B4,5+B5,5+B6)

	 3.	 The project will end on the 18-10-2012, as given below:

	

Keyboard Shortcuts to Access the Ribbon Programs

Question:	 How do I access any ribbon command in a few keystrokes?   

Answer:	 By using access keys: Access keys provide a way to quickly use a command by pressing 
a few keystrokes, no matter where you are in the program. Every command in a program 
that uses an Office Fluent ribbon can be accessed by using an access key. You can get to 
most commands by using two to four keystrokes. 

Why:	 To access any ribbon command in a few keystrokes.
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Process (Excel 2010 and Excel 2007): 

	 1.	 Press and release the ALT key.

		  The KeyTips are displayed over each feature that is available in the current view.

	 2.	 To apply conditional formatting using access keys, refer to the data below: 

	 3.	 Select C2:C18.

	 4.	 Press the ALT key.

	 5.	 Press H.

	 6.	 Press L.

	 7.	 Press H.

	 8.	 Press G.

	 9.	 Enter as below:

	 10.	 Press the Enter Key.

	 11.	 The result is as below:
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Date Data Validation

Question:  I would like to ensure that the end date is greater than the start date. Can this be done in 
MS Excel?  

Answer:	 Yes, using Data Validation. 

Why:	 When entering project tasks, you must make the end date greater than the start date.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below:

	 2.	 Select the range; C2:C8.

	 3.	 From the Data tab, in the Data Tools group, select Data Validation.

	 4.	 Select as below:

	 5.	 Select the OK button.

	 6.	 Enter 01/01/2011 in cell C2. An error message given below is displayed since 01/01/2011  
is less than 14/01/2011.

Thus, one is able to ensure that the data that users enter into a worksheet conforms to certain stan-
dards by enforcing the data validation rule.
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GETPIVOTDATA

Question:	 Is there a way to quickly extract certain data from a PivotTable in Microsoft Excel? 

Answer:	 Yes, using the GETPIVOTDATA function. 

Description:	 Returns data stored in a PivotTable report. You can use GETPIVOTDATA to retrieve 
summary data from a PivotTable report, provided the summary data is visible in  
the report.

Process (Excel 2010 and Excel 2007): 

	 1.	The PivotTable report below includes detailed information on the sales by customer and  
	 product; to easily extract the Grand Total for Sales, you can use the GETPIVOTDATA function.

	 2.	Select in a blank cell and enter the following GETPIVOTDATA function:

		  =GETPIVOTDATA(“TotalSale”,$E$10)

	 3.	This gives you the Grand Total Figure for Total Sale $1,029,790.03.

SYNTAX:

GETPIVOTDATA(data_field, pivot_table, [field1, item1, field2, item2], ...)

The GETPIVOTDATA function syntax has the following arguments:

•	 Data_field Required. The name, enclosed in quotation marks, for the data field that contains  
the data that you want to retrieve

•	 Pivot_table Required. A reference to any cell, range of cells, or named range of cells in a  
PivotTable report. This information is used to determine which PivotTable report contains the 
data that you want to retrieve

•	 Field1, Item1, Field2, Item2 Optional. 1 to 126 pairs of field names and item names that  
describe the data that you want to retrieve. The pairs can be in any order. Field names and 
names for items other than dates and numbers are enclosed in quotation marks.
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Data Validation With Formula

Question:	 I send out a weekly stock report to the stock controller to update with the new stock items 
that come into the warehouse. In this Excel report the cell that contains a product code 
name always needs to begin with a standard prefix of ID- and must be at least ten characters 
long. How do I ensure that the stock controller captures the Product IDs correctly?   

Answer:	 By using a Formula in a Data Validation to calculate what is allowed to be captured. 

Process (Excel 2010 and Excel 2007): 

	 1.	 Apply Data Validation to column A (ProductID) to ensure that Product IDs are entered correctly 
in future.

	 2.	 Select the Data Tab, Go to Data Validation.

	 3.	 Enter the following criteria for the Data Validation Settings Window

			   •  Allow: Custom

			   •  Formula: AND(LEFT(A2,3)=”ID-“,LEN(A2)>9)

	 4.	 Enter the following criteria for the Data Validation Input Message Window:

	 5.	 Enter the following criteria for the Data Validation Error Alert Window:
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	 6.	 Insert the following Product ID’s into Column A

			   • ID-23456789

 

			   • ID456878673

 

You get an Error alerting you that the Incorrect Product ID has been entered

Note: The input message prompts you to enter the correct Product IDs.

IF Function

Question:	 I have number of sales employees in my organization, and I would like to automatically cal-
culate, if they reach a certain target, their commission based on their above target figures. 
If they reach a specific above target I want to multiply this target by a set percentage;  
if they don’t reach the target, I need this target, figure to be multiplied by a different  
percentage.  

Answer:	 Use the IF Function. The IF function is one of Excel’s most useful and most used func-
tions. What it does, basically, is test to see whether a certain condition is true or false.  
If the condition is true, the function will do one thing, if the condition is false, the function 
will do something else.

	 Syntax: =IF(logic test, value if true, value if false) 

Process: 

	 1.	 Calculate the commission figures for the following employees. Base on the following criteria. 
If the above target figure is above the target benchmark of $10,000 then multiply the value by 
20% if the above target figure is below $10,000 then multiply the figure by 5%.
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	 2.	 You can use the IF Statement.

	 3.	 Use the following formula and copy down =IF(B5>10000,B5*20%,B5*5%).

	 4.	 The commission figures are automatically calculated based on the IF function.

	 5.	 The logic test is always a comparison between two values. Comparison operators are used, for 
example, to see if the first value is greater than or less than the second or equal to it.

	 6.	 While the logic test section is limited to answering a true or false question, you have greater 
flexibility in what you place in the last two arguments.

	 7.	 The IF function can perform different calculations depending on whether the function returns a 
true value or not.

Note: There is no comma separator used for the number in 10,000 in the above example. This is 
because the IF function uses the comma to separate the three sections of the IF function contained 
within the round brackets.

Hlookup

Question:	 How can I search for a value in the top row of the table and then return a value in the 
same column from a specified row?   

Answer:	 By using Hlookup. 

Why:	 To perform a horizontal lookup on a data list.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below:

	 2.	 To find the total sales for the South Coast, select any empty cell. Select as below:
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	 3.	 Enter as below and select OK.

		  The answer is $40,000.00.

The formula can also be entered as  =HLOOKUP(C2,B2:E6,4,False)

	The syntax of the Hlookup formula is as given below:

= HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])

Lookup_value. The value to be found in the first row of the table. Lookup_value can be a 		
value, a reference, or a text string.

Table_array. A table of information in which data is looked up. Use a reference to a range or 		
a range name.

Row_index_num. The row number in table_array from which the matching value is 		
returned. 

Range_lookup. A logical value that specifies whether you want HLOOKUP to find an exact 	
match or an approximate match. If TRUE or omitted, an approximate match is returned. If 		
FALSE, HLOOKUP finds an exact match.

Creating the Slicer Connection to Second PivotTable

Question:  Can you connect a slicer to more than one PivotTable?    

Answer:	 Yes, by using the Slicers connection functionality. If you have created two PivotTables and 
you have created a slicer off the PivotTable1, you can connect the same slicer to use Filter 
on the PivotTable2. 

Process (Excel 2010): 

	 1.	 Select a cell in the second PivotTable. 

	 2.	 On the Excel Ribbon’s Options tab, click Insert Slicer.

	 3.	 Click Slicer Connections.
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	 4.	 In the Slicer Connections window, add a check mark the slicer to Connect to PivotTable2.

Both PivotTables are now connected to the Slicer. If you select an item in a slicer, both PivotTables are 
filtered. For example, in the Warehouse slicer below, Central is selected, and both PivotTables show 
only the Central Warehouse-related data.

Before Filter:

 

After Filter (Central Warehouse):
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Autogeneration of Names

Question:	 How do I automatically generate names from the top row of the selected data?   

Answer:	 By defining names with the Create from Selection option. 

Why:	 To automatically generate names from selected text.

	 By using names (name: A word or string of characters in Excel that represents a cell, 
range of cells, formula, or constant value.), you can make your formulas much easier to 
understand and maintain. You can define a name for a cell range, function, constant, 
or table. Once you adopt the practice of using names in your workbook, you can easily 
update, audit, and manage these names.

Process (Excel 2010, Excel 2007, and Excel 2003):
	
1.	 Refer to the data given below:

	 2.	 Highlight cells A3:F25.

	 3.	 Select as below:

	 4.	 Select Top row and then the OK button as given below:
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	 5.	 Select Name Manager under the Defined Names group.

	 6.	 A list of names confirms that the column headings have been automatically generated as the 
names for the corresponding data.

Creating a 3-D Reference Name

Question:	 How do I create a reference (name) that refers to the same cell or range on  
multiple sheets?   

Answer:	 By creating a 3-D reference name. 

Why:	 A 3-D reference is a useful and convenient way to reference several worksheets that  
follow the same pattern and contain the same type of data, such as when you consolidate 
budget data from different departments in your organization.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the data given below. The Operations Budget figures for the North, South, East, and 
West are captured on the respective worksheets as given below. The consolidated budget 
figure is displayed on the summary worksheet.

		  The budget figures captured on the South, East, and West worksheets in the order of the 
months given above is:

		  South: $51,000, $32,000, $45,000, $74,000, $90,000, $88,000

		  East: $120,000, $95,000, $88,000, $93,000, $54,000, $34,000

		  West: $45,000, $34,000, $87,000, $89,000, $56,000, $77,000
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	 2.	 Select C4:C9 on the North worksheet.

	 3.	 Select as below:

	 4.	 Select New on the Name Manager window and select as below:

	 5.	 Select OK and then select the close button.

	 6.	 Select cell G9 on the summary worksheet and enter the following formula: =Sum(RegionTotals)

	 7.	 Press the Enter Key.

	 8.	 The consolidated Regional Total Value of $1,598,000.00 is displayed.

Large Function

Question:	 I know how to find the largest value from a given data range by using the maximum  
function. But how can I find the second-largest value from a data range? 

Answer:	 By using the LARGE function. 

	 Syntax: =Large(Array,K)		
	 Array is an array or range of numerical data for which you want to determine the 			

k-th largest value.
	 K is the position (from the largest) in the array or range of data to return.

Why:	 Returns the k-th largest value in a data set. You can use this function to select a value 
based on its relative standing. For example, you can use LARGE to return the highest, 
runner-up, or third-place score.
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Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 To find the second-largest value from the following data range:

	 2.	 Select cell B19 and type =Large(B2:B17,2).

	 3.	 The answer is $2,128.00 meaning the second-best salesperson is Johnson A.

The LARGE function can also be used as an alternative to the MAX function.

TRIM Function

Question:	 I have just imported data into MS Excel. How do I remove leading or trailing spaces from 
the data? I also would like to limit the amount of space between words to one.  

Answer:	 By using the TRIM function. 

Why:	 Removes all spaces from text except for single spaces between words. Use TRIM on text 
that you have received from another application that may have irregular spacing.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 For this example the screen shot given below is used:
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	 2.	 Select cell B2 and type =Trim(A2) then press enter. Drag the formula down.

	 3.	 The result is as follows:

As you can see from the data above, all spaces from the text except for single spaces between words 
have been removed.

Small Function

Question:	 Is there an alternative to the minimum function when finding the smallest value in a given 
data range?   

Answer:	 Yes, the Small function. 

	 Syntax: SMALL(array,k)
	 Array is an array or range of numerical data for which you want to determine the 			

k-th smallest value.
	 K is the position (from the smallest) in the array or range of data to return.

Why:	 Returns the k-th smallest value in a data set. Use this function to return values with a 
particular relative standing in a data set.
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Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 Refer to the following screen shot used for this example:

	 2.	 Select cell B19 and type =Small(B2:B17,1).

	 3.	 The answer is $29.20, meaning the salesperson with the lowest sales value is Anderson P.

Mode Function

Question:	 We commissioned a research into the buying habits of our clients. How can we find the 
most frequently ordered quantity of our product?   

Answer:	 By using the Mode function. 

	 Syntax: MODE(number1,number2,...)
	 Number1, number2, ...  are 1 to 255 arguments for which you want to calculate the mode. 

You can also use a single array or a reference to an array instead of arguments separated 
by commas.

Why:	 Returns the most frequently occurring, or repetitive, value in an array or range of data.

Remarks: Arguments can either be numbers or names, arrays, or references that contain numbers. If 
an array or reference argument contains text, logical values, or empty cells, those values are ignored.

Process (Excel 2010, Excel 2007, and Excel 2003):

	 1.	 For this example the following screen shot is used:
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 	 2.	 To find the mode, select B12 and type =Mode(B3:B11).

	 3.	 The answer is 10.

	 4.	 Meaning the quantity of product A that most clients ordered is 10.

Transpose Option

Question:	 Can I return a horizontal range of cells as a vertical range, or vice versa?   

Answer:	 Yes, using the transpose option. 

Why:	 To change the positional alignment of the data.

Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 For this example we shall make use of the screen shot given below:

	 2.	 Select cells A1:O1.

	 3.	 Press Ctrl + C.

	 4.	 Select cell D4.

	 5.	 Select as below:
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	 6.	 Select Transpose then OK.

	 7.	 Select cells A1:O1 then press the delete key.

	 8.	 The result is as follows:

Initially the data in row 1 was aligned horizontally but has been changed to vertical alignment and 
placed in column D by using the transpose option.

REPT Function

Question:	 How do I display the total sales amount by way of a chart? I don’t want to use the normal 
chart options given in Excel. Is there an alternative to the normal chart options?   

Answer:	 Yes, the REPT function. 

	 Syntax: REPT(text,number_times)
	 Text Required. The text you want to repeat
	 Number_times Required. A positive number specifying the number of times to repeat text

Why:	 Repeats text a given number of times. Use REPT to fill a cell with a number of instances of 
a text string.
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Process (Excel 2010, Excel 2007, and Excel 2003): 

	 1.	 The screen shot below are used to illustrate this example:

	 2.	 Select cell D4 and type =REPT(“I”,C4) & C4.

	 3.	 The result is as follows:



Contact Information

BI Community:	
http://community.alchemex.com

Online Training Academy:	
www.SageU.com

E-Newsletters:	
http://www.alchemex.com/SubscribeNewsletters.aspx

BI Blog:	
http://www.alchemex.com/blog/

Intelligence Reporting
The Intelligence Reporting module in Sage software empowers you to quickly and easily obtain the information required for improved 
operations and reporting across your entire business. Based on the familiar Microsoft® Excel® application, the Intelligence Reporting 
module lets you effortlessly create reports and analyze data, improving visibility into your organization. Intelligence Reporting integrates 
with Sage 50 Accounting—U.S. Edition, Sage 50 Accounting—Canadian Edition, Sage 100 ERP, Sage 300 ERP, Sage 500 ERP, Sage 
PFW ERP, and Sage ERP X3.

About Sage
Sage North America is part of The Sage Group plc, a leading global supplier of business management software and services. At Sage, 
we live and breathe business every day. We are passionate about helping our customers achieve their ambitions. Our range of business 
software and services is continually evolving as we innovate to answer our customers’ needs. Our solutions support accounting, 
operations, customer relationship management, human resources, time tracking, merchant services, and the specialized needs of the 
construction, distribution, manufacturing, nonprofit, and real estate industries. The Sage Group plc, formed in 1981, was floated on the 
London Stock Exchange in 1989 and now employs 12,600 people and supports more than 6 million customers worldwide. For more 
information, please visit the website at www.NA.Sage.com or call 866-996-7243. Follow Sage North America on Facebook at: http://
www.facebook.com/SageNorthAmerica and Twitter at: http://twitter.com/#!/sagenamerica.

©2012 Sage Software, Inc. All rights reserved. Sage, the Sage logos, and the Sage product and service 
names mentioned herein are registered trademarks or trademarks of Sage Software, Inc., or its affiliated 
entities. All other trademarks are the property of their respective owners.           EXL5_TTR_EBK  06/12


